SAP Business One 10.0
Release Highlights

Global Partner Enablement, SAP Business One
December, 2021

Note to Customers, Partners, and Others
This material may not be published on other platforms or websites outside SAP.
Please note the copyright "No part of this publication may be reproduced or transmitted in any form or for any purpose without the express permission of SAP SE...".
To reference the latest material please use this link.
The information in this presentation is confidential and proprietary to SAP and may not be disclosed without the permission of SAP. This presentation is not subject to your license agreement or any other service or subscription agreement with SAP. SAP has no obligation to pursue any course of business outlined in this document or any related presentation, or to develop or release any functionality mentioned therein. This document, or any related presentation and SAP’s strategy and possible future developments, products and or platforms directions and functionality are all subject to change and may be changed by SAP at any time for any reason without notice. The information in this document is not a commitment, promise or legal obligation to deliver any material, code or functionality. This document is provided without a warranty of any kind, either express or implied, including but not limited to, the implied warranties of merchantability, fitness for a particular purpose, or non-infringement. This document is for informational purposes and may not be incorporated into a contract. SAP assumes no responsibility for errors or omissions in this document, except if such damages were caused by SAP’s willful misconduct or gross negligence.

All forward-looking statements are subject to various risks and uncertainties that could cause actual results to differ materially from expectations. Readers are cautioned not to place undue reliance on these forward-looking statements, which speak only as of their dates, and they should not be relied upon in making purchasing decisions.
SAP Business One 10.0 Enhancements (1/2)

- SAP Note [2826255](#) - Central Note for SAP Business One 10.0
- SAP Note [2826199](#) - Central Note for SAP Business One 10.0, version for SAP HANA

**Web Client**
- Web Client for SAP Business One
- Web Client – Enhance Delivered Objects
- Web Client – Support Message Preferences
- Web Client - Enhancements in Outgoing SnB/Bin Location Selection
- Web Client - Support BP Catalog Number
- Web Client - Support Purchase Quotation & Purchase Order
- Web Client - Service Module
- Web Client - Support Goods Receipt PO & A/P Invoice
- Web Client - Support Payments
- Web Client - Time Sheet
- Web Client - User-Defined Queries (UDQs)
- Web Client - Analytics Enhancements
- Web Client - Outlook 365 Enhancements
- MS Teams - Access Web Client List View & Detailed View
- MS Teams - Access Dashboards & Charts
- Web Client - Extensibility Support

**Administration**
- Support Expiration Date
- Enhancements in Document Printing
- Referenced Document Enhancements
- Support Attachments Tab in Additional Objects
- Increased Field Lengths
- Enhancements in Approval Process
- New Overview Window: Alerts Management
- Tab-Level Authorizations in Master Data
- Administration Enhancements
- Product Documentation Moved to SAP Help Portal
- Business Process Enhancements

**Usability**
- New Skin Style
- Enhanced User Interface
- Alignment of Form Behavior
- User Name in License & Add-On Administration

**Financial Management**
- Drill Down to G/L Accounts in Financial Reports
- Posting Periods Enhancements
- Extend Journal Entry Remarks to 254 Characters and Increase Length of Ref.3 Fields
- Financial Management Enhancements
- Period End Closing - Journal Entry Series
- Fixed Assets Enhancement

**Localization**
- New UK (Brexit) Localization
## SAP Business One 10.0 Enhancements (2/2)

### Sales | Purchasing | Service
- Backorder Report Enhancements
- Printing Service Calls & Contracts
- Hide Blank Lines in Addresses
- Add Button Extended in Marketing Documents
- Enhanced Open Items List Report
- EU PEPPOL E-Invoicing

### Sales | Purchasing | Service Enhancements
- SAP Business One Sales and Service Mobile Apps

### Project Management
- Interactive Gantt Chart

### Inventory | Distribution
- Serial & Batch Numbers Management
- Ability to change UoM Group of an item

### Production
- Bill of Materials (BoM) Description Enhancements
- Drill Down from BoM to Item Master Data

### Platform | Extensibility
- Service Layer Enabled for Microsoft SQL Server
- Service Layer Configuration UI
- Formatted Search Supports Multiple Triggers
- Extend UDF Support to Additional Objects
- Microsoft Office 365 Integration
- 64-bit Support Only
- GateKeeper (Browser Access) Service
- DI API | Service Layer | Platform | Integration Framework Enhancements
- Web Client - Extensibility Support
Web Client
SAP Business One 10.0 (MS SQL)  PL02 Update
SAP Business One 10.0, version for SAP HANA
The Web Client* is based on SAP Fiori design principles encapsulating SAP Business One core processes and business logic alongside an advanced user experience.

- Focused on creation, processing and updating of Sales Quotations, Sales Orders, A/R Deliveries, and A/R Invoices (PL01)
- List views for purchasing documents (PL02)
- Supports creation and update of Items, Business Partners, and Activities
- The Web Client provides some sophisticated analytic charting capabilities
- For optimized user experience launch the Web Client in either a desktop computer or tablet, using the Google Chrome or Firefox web browser. The Web Client can also be launched directly from the regular SAP Business One desktop application.

* The Web Client delivered with SAP Business One 10.0 PL02 is supported by all SAP Business One localizations. Brazil and India in view mode only.
Learn about the Web Client here
For latest features check the What’s New document

- Enhance delivered objects (Business Partner, Items, Activity, Sales Quotation, Sales Order, Delivery, and Invoice)
- Extend sales support (Return, A/R Credit Memo, and A/R Reserve invoice)
- Support of outgoing serial and batch numbers/bin location selection
- Extend localization support
- Support CRM
- Enhance Analytical capabilities
- Support Microsoft 365 (Excel)
- Extensibility support (URL mashup, Fiori/HTML5 app support)
- Web Assistant Adoption
Web Client - Enhance Delivered Objects

- **Business Partner Master Data Support**
  - Checks balance for customers

- **Additional fields and columns are added to the Opportunities list view for more flexible and efficient filtering options**

- **Cancelling A/R Credit Memo via list view is supported**

- **Enable upload BP image using camera**
Web Client - Support Message Preferences

- Message Preferences form is added to Settings section under the user area, enabling users to review their message preferences and change it as required:
  - Display a message that is currently not displayed
  - Change the answer to be applied in case a message is not displayed
- The settings done on the Web client apply to the same messages on the regular client and vice versa
Web Client - Enhancements in Outgoing SnB/Bin Location Selection

- Auto select button is added to lists of bin locations and serial and batch numbers selection to increase efficiency
- The Batch/Serial Numbers and Bin Location columns are editable, enabling the user to start typing directly the required value and the auto-suggest feature lists the most suitable values accordingly
Web Client - Support BP Catalog Number

FP2108 Update

- A new app for Business Partner Catalog Number is added under Business Partners module
- Here you can view, define, update and remove catalog numbers grouped by business partner, as well as set default and duplicate selected items
- Using the filter-bar you can filter the list for better efficiency
- Like in other lists, you can export BP catalog numbers to Excel
- The "BP Catalog Number" button added to business partner and item master data headers opens the list of catalog numbers defined for the given business partner or item
Web Client - Support Purchase Quotation & Purchase Order

FP2108 Update

- New apps for creating and processing Purchase Quotation and Purchase Order are available
- In addition, the Purchase Quotations and Purchase Orders apps are enhanced to support:
  - View, process and create Purchase Quotations and Purchase Orders
  - Batch operations for selected records—such as Close and Cancel
The Service module in the Web client enables you to create and process service calls and solutions.

The Service Calls and Solution Knowledge Base list views provide you with comprehensive overview and enable you to generate respective reports.

Enhanced user-interface design enables the user to view selected solution side-by-side the respective service call, gaining the benefit of having all information in one place.
Web Client - Enhance Analytic Capabilities

- Card view option is added to all list views, including UDOs & UDTs
- The Card View enables you to create sets of analytical cards for a given object using dedicated editor and save it as view for future use

FP2108 Update
Web Client - Enhance Delivered Objects

- Support “Reset” in Home Page Groups
- You can re-position rows in Sales & Purchasing Documents in “Create” mode, and in “Edit” mode in Quotations and Orders
- Serial/Batch and Bin Location Auto-Allocation For Outbound Transaction
- The “Notification Center” is enhanced to display notifications when a service call is assigned to you as a user or as a technician
- Service Calls list view is enhanced to support “close” and “reopen” of single/multiple service calls and the filter bar is enriched with additional fields
- “Business Partner Addresses” view is added to the Manage Business Partners list view
- Business Card scanning is supported
- List views support copying only part of the document rows to target document
- Draft watermark is supported for draft preview
The apps “Goods Receipt POs” and “A/P Invoices” enable you to manage, process and create Goods Receipt POs and A/P invoices.

The apps “Create Goods Receipt PO” and “Create A/P Invoice” enable you to launch the respective document form in “Add” mode to efficiently create new documents.
Web Client - Support Payments

- Incoming and Outgoing Payments apps are available, enabling you to manage, create, and cancel payments.
- You can create payments for business partners or accounts – dedicated apps provide quick launch of the required form.
- You can visualize the payment mean related columns in the List View and include them for filtering options.
- Supported payment means are cash and bank transfer.

FP2111 Update
Web Client - Time Sheet

FP2111 Update

- New apps “Time Sheets” and “Create Time Sheet” are available
- You can view, create and update time sheets for users, employees, or external contractors
The “User-Defined Queries” app enables you to create, edit, preview, generate, and remove user-defined queries without parameters (update queries are not supported).

- You can open the queries in a list view, apply filters, manage views, and save it as a tile, same as any other list view.
- The queries can be used as “Data Source” when editing or designing analytic cards in Overview pages.
- User-Defined Queries created in the Web Client will be available also in the Query Manager of the B1 client.
Web Client - Analytics Enhancements

- New options are added to the date picker to allow more flexibility of date ranges:
  - Last X posting periods
  - Next X posting periods
- The “Date Offset” calculation is enhanced to support specific month of the year e.g. January, or a day of the week, e.g. Monday. In addition, the expressions “PostingPeriod:Begin” and “PostingPeriod:End” are supported.
Web Client - Outlook 365 Enhancements

- New control of sending e-mail directly from sales documents in Web Client through linked Microsoft 365 Outlook account
- User may review final e-mail before it is finally sent through linked Outlook 365 account.
- Word file with exported document is attached to such e-mail
- Default text and subject of an e-mail message can be set at Print Preferences
MS Teams - Access Web Client List View & Detailed View

**Requirement**
- Different roles in a sales team, for example, sales managers, marketers, and pre-sales, can view all Web Client views directly in MS Teams to improve collaboration across departments and systems while working on the same business potentials.

**Capabilities**
- Add any list view & detailed view to Tab View of MS Teams
- View all authorized view in MS Teams

**Benefits for Customers**
- Collaborate and manage work easily without changing systems
- Increase productivity and work efficiency
MS Teams - Access Dashboards & Charts

Requirement
- Users can view Dashboards & Charts directly in MS Teams to improve collaboration across departments and systems while working on the same business topic.

Capabilities
- Add Dashboards & Charts in Tab View of MS Teams
- View all authorized Dashboards & Charts in MS Teams

Benefits for Customers
- Collaborate and manage work easily without changing systems
- Increase productivity and work efficiency
Web Client - Extensibility Support

- Support displaying KPIs on extension tiles
- Support MS Blazor by VSCode Template Wizard
- Support APIs for new views
- Online help enhancements
Usability
SAP Business One 10.0
New Skin Style - Belize Deep

Feature
- New skin style “Belize Deep” is added to SAP Business One 10.0, version for SAP HANA.
- Inspired by the SAP Fiori design and following the Web Client look & feel
- Currently available when using the Fiori-Style Cockpit
- 4K monitors supported when using the Belize Deep skin style

Benefit
- Modern and fresh look and feel
- Harmonized user-experience for those who work with both SAP Business One and the Web Client
Enhanced User Interface

**Feature**

- New icon and menu option under the *View* menu enables the showing or hiding of the toolbar.
- Users can enlarge working area by hiding the toolbar.
- The company name and user name are clearly displayed at the top center of SAP Business One window; Click it to open the “Choose Company” window directly.

**Benefit**

- Information about current company and logged-on user is displayed clearly.
- Switching between company databases and users is one-click away.
Alignment of Form Behavior

Feature
- Ability to resize and maximize form size is supported in: Company Details, General Settings, Posting Periods, Print Preferences, Checks for Payment, Document Generation Wizard, Update Special Prices Globally, Trial Balance Revaluation, General Ledger, Layout and Sequence, Request for Generation Approval, Approval Stages, Export Transactions to SAP Business One, Payment Methods, Payment Terms, Query Authorization Groups, Report and Layout Manager, UDF - Field Data, Configuration Management, Cash Flow, Add-on Manager

Benefit
- Increased usability by avoiding scrolling, especially in busy forms
- Alignment with standard system form behavior
User Name in License & Add-On Administration

Feature

- A new column for displaying the User Name is added to the Allocation and Assignment tabs in License Administration window and to the User Preferences tab in Add-on Administration window
- Filtering according to User Name field is now possible within both forms
- Sorting by User Name is supported in the License Administration window

Benefit

- Enhanced clarity and transparency of the user’s identity by displaying the user name supports accurate license allocation and add-on administration
Business Process Enhancements

- Change Log for Exchange Rates lists changes made in the regular client and the Web client
- Configure display mode for Employee Name
- Refresh button is enabled for Balance Sheet Comparison Report
- Support sorting for project stages
- Clear display of Company Name in minimized client window
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide Locked User</td>
<td>A new checkbox ‘Hide Locked User’ is available in the Add-on Administration, UI Configuration Template, Alerts Management, and Copy Form Settings (Users – Setup) windows. SAP Note 2970933 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Add Queries to SAP Business One Menu</td>
<td>Queries can be added to the SAP Business One menu via the Query Manager window choosing the Assign to Menu option. In the Query Menu Registration window select the Menu Item checkbox and specify the details where this query should be positioned. The display of the query is related to the user’s authorization. SAP Note 2970958 (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Import User-Defined Tables (UDT) from Microsoft Excel</td>
<td>User-Defined Tables (UDT) can be imported from Microsoft Excel. In the Data Type to Import dropdown list the entry User-Defined Tables is available based on the UDT form authorization. SAP Note 2970949 (FP2011)</td>
<td>All</td>
</tr>
</tbody>
</table>
Administration
SAP Business One 10.0
Support Expiration Date

Feature

- The information Support Expiration Date is shown in the About SAP Business One window
- Version Name in About window is changed to quarterly release cycle (FP2008)

See SAP Note 2957553

Benefit

- Simplifies support by having necessary information available in one screen
Enhancements in Document Printing

Feature

- The selection criteria for document printing is enriched with additional options according to the selected document type
- Form Settings window is added to the “Print <document>” window allowing the user to customize the column display
- The “Print <document>” window now supports table sorting and filtering

Benefit

- The enhanced selection criteria enables you to optimize batch printing
- Increased usability and productivity especially when printing a high number of documents
Referenced Document Enhancements

Feature

- You are now able to reference documents in Checks For Payment, Purchase Request, Goods Receipt & Issue, Inventory Transfer Request, and Inventory Transfer
- Numeric indication for number of referenced documents
- Automatic referenced document creation from applicable marketing documents
- Recurring Postings can be referenced to a single document. This document contains a reference to each recurring posting created. The referenced by tab displays then the cross referencing to the recurring posting itself.
- Module-sorted list of documents to reference
- Document Referencing is available for Incoming and Outgoing Payments, Inventory Revaluation, Inventory Counting, and Inventory Posting (FP2008) - SAP Note 2945089
- When duplicating a document, a reference between the original and duplicated document can be created (FP2011) - SAP Note 2958941

Benefit

- Extended coverage of referenced documents across SAP Business One modules
- Better visibility of when documents are referenced
Support Attachments Tab in Additional Objects

Feature
- The Attachments Tab is now available in Inventory Opening Balance*, Inventory Counting, Inventory Posting*, Incoming Payments*, Outgoing Payments*, Check for Payments*, Deposit, Journal Entry, Production Order, and Time Sheet*
- *Due to the addition of the Attachments tab, the Contents tab now holds the original details of the form/General tab

Benefit
- Support managing attachments for additional objects and streamline system behavior
Field Length Increase

**Feature**

- **Customer Group Name** and **Supplier Group Name** may contain up to 100 characters.
- The **Item Group Name** also supports 100 characters.
- The length of the **Item Description** field in the **Item Master Data** window is 200 characters (**FP2008**). See SAP Note [2949632](#).
- The field length of **Industry Name** is 40 characters and of **Industry Description** is 120 characters (**FP2008**). See SAP Note [2931333](#).

**Benefit**

- More flexibility for the values entered in these fields.
- Standardization of product field definitions.
Enhancements in Approval Process

Feature

- New setting enables approvers to update draft document in Pending status
- Last Updated By and Last Updated On fields are now available within the Request for Generation Approval form
- Approval Status Report now contains Draft Updated By, Draft Update Date, Draft Update Time, and Draft Remarks fields
- Both the authorizer and the originator can add the document for approval
- Substitute Authorizers for approval templates are enabled when the authorizer is out of office (FP2105)

Benefit

- Minimizes unnecessary back and forth between authorizer and originator
- Simplifies approval procedures and adds even more flexibility
New Overview Window: Alerts Management

SAP Note 2945182

Feature
- New window Alerts Management available
- Overview of system and user alerts
- Filter option
- Actions button to create:
  - New user alerts
  - Set alerts to active or inactive
  - Remove alerts

Benefit
- Simplifies alerts management
- Better overview on existing alerts
Tab-Level Authorizations in Master Data Records

Feature

- Different authorizations can be granted to different tabs in Business Partner Master Data and Item Master Data
- If a user has no authorization for a given tab, this tab will be automatically hidden

Benefit

- Enables the granting of more accurate authorizations to each user, based on tasks and responsibilities
- Helps to prevent human errors and increases data protection
- Increases productivity
Product documentation shipment methodology is enhanced. The documentation deliverables in the Documentation folder have moved to SAP Help Portal where you can access the latest (and previous) product documentation.
Business Process Enhancements

- Attachments tab is added to Bill of Materials along side a new setting to determine whether to copy attachments from BoM to Production Order. In addition, new setting that enables to determine whether to overwrite attachments with same file name is available
- Blanket Agreement Fulfillment Report is enhanced to display four new columns: Cumulative Ordered Quantity / Amount and Total Open Quantity / Amount
- The Query Manager is enhanced to support renaming of user queries. In addition, you can edit a user query without executing it, just by using the “Edit” option in the context menu
- Support “Change Log” for teams update in Employee Master Data
- “Telephone” field length is increased to 50 characters
- “Foreign Name” field length in Item Master Data is increased to 200 characters
### Administration

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Log Window Enhancements</td>
<td>New columns “Created On/At” and “Updated On/At” are added to the Change Log window to see the specific date and time. SAP Note <a href="FP2008">2957436</a></td>
<td>All</td>
</tr>
<tr>
<td>Manually Entering Paths</td>
<td>Paths can be manually entered or pasted on the Path tab in the General Settings window. SAP Note <a href="FP2008">2949641</a></td>
<td>All</td>
</tr>
<tr>
<td>Shipping Types Deactivation</td>
<td>New checkbox Active is available in the Shipping Types window under Administration → Setup → Inventory → Shipping Types to activate or deactivate shipping types. SAP Note <a href="FP2008">2950719</a></td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Warning Message When Choosing ‘Personal Blocking’</td>
<td>When choosing <em>Personal Data Blocking</em> in the <em>Personal Data Management Wizard</em> a warning message is displayed if the <em>BP Balance</em> amount is not zero. SAP Note <a href="https://support.sap.com/2946064">2946064</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Authorization for ‘Copy Table’ Function</td>
<td>In the <em>General Authorizations</em> a new authorization <em>Copy Table</em> is available with <em>Full Authorization</em> and <em>No Authorization</em>. In new installations and after upgrades the default setting for the <em>Copy Table</em> authorization is <em>Full Authorization</em>; for new users, <em>No Authorization</em> is selected by default. SAP Note <a href="https://support.sap.com/2970937">2970937</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Configure License Balloon Appearance</td>
<td>A new checkbox <em>Show License Information at Startup</em> is added to the <em>Users – Setup</em> window -&gt; <em>Services</em> tab to set whether the license balloon will be displayed after logging in. The checkbox is reset to default (balloon is displayed): - Every 3 months / 90 days - When upgrading to a higher patch or release SAP Note <a href="https://support.sap.com/2970959">2970959</a> (FP2011)</td>
<td>All</td>
</tr>
</tbody>
</table>
### Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| **Enhancement of Check on Duplicate Customer/Vendor Reference Number** | Under Administration → System Initialization → Document Settings → Per Document tab, select a sales or purchasing document type, under When Duplicated Customer Reference No. Occurs: When selecting Warning Only or Block Release/Receipt the following options are available:  
  - Check for Duplicate Under  
    - Individual Customer Only  
    - All Customers  
  - Check for Duplicate in Current Fiscal Year Only | All                                                      |              |

SAP Note [2970936 (FP2011)]
### Administration

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Authorization to Remove Opportunity</td>
<td>Authorization is required for new users to remove an opportunity. Assign authorization under <strong>Administration</strong> -&gt; <strong>System Initialization</strong> -&gt; <strong>Authorizations</strong> -&gt; <strong>General Authorizations</strong> -&gt; <strong>Opportunities</strong> -&gt; <strong>Special Opportunity Authorizations</strong> -&gt; <strong>Remove Opportunity</strong>&lt;br&gt;SAP Note <a href="https://launchpad.support.sap.com/?id=2985725">2985725</a> (FP2102)</td>
<td>All</td>
</tr>
<tr>
<td>Authorization to View Other Users’ Payment Drafts in Drafts Report</td>
<td>Regular users can view incoming and outgoing payment drafts created by other users respectively, if the following two authorizations are given:&lt;br&gt;- <strong>View Incoming Payment Drafts Created by Other Users</strong>&lt;br&gt;- <strong>View Outgoing Payment Drafts Created by Other Users</strong>&lt;br&gt;Define Authorizations under <strong>Administration</strong> -&gt; <strong>System Initialization</strong> -&gt; <strong>Authorizations</strong> -&gt; <strong>General Authorizations</strong> -&gt; <strong>Banking</strong> -&gt; <strong>Outgoing Payments</strong> -&gt; <strong>Payments Drafts Report</strong>&lt;br&gt;SAP Note <a href="https://launchpad.support.sap.com/?id=2990653">2990653</a> (FP2102)</td>
<td>All</td>
</tr>
<tr>
<td>Copy Selected Forms Between Users</td>
<td>An admin user is able to copy selected forms' settings from one user to another.&lt;br&gt;SAP Note <a href="https://launchpad.support.sap.com/?id=2979530">2979530</a> (FP2102)</td>
<td>All</td>
</tr>
</tbody>
</table>
## Access to Change Log for User with Read-Only Authorization for Specific Object

Users with full authorizations for *Change Log* and read-only authorizations for the following documents can view their change logs:

- Sales and purchasing documents
- Journal Entries
- Goods Issues, Goods Receipts, Receipts from Production, and Issues for Production
- Inventory Transfers and Inventory Transfer Requests
- Inventory Opening Balances, Inventory Counting, and Inventory Postings
- Incoming Payments and Outgoing Payments

SAP Note [2303812](https://support.sap.com/2303812) (FP2102)

### Localization

- All
### Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| **User Codes in Change Log and Differences**                           | News fields and columns are available for the *Change Log (Tools -> Change Log)* and *Differences* to display unique information listed by user code:  
  - Updated By – User Code  
  - Created By – User Code  
  SAP Note [3031630](FP2105)                                           | All                                                      |
Drill Down to G/L Account in Financial Reports

Feature

- Golden arrows are added next to the account codes in financial reports allowing users to drill down into the account record within the Chart of Accounts
- Available in Balance Sheet, Trial Balance, and Profit and Loss Statement

Benefit

- Direct access to account details and account balance of relevant accounts increases usability and transparency
- Streamlined with standard system behavior
Posting Periods Enhancements

**Feature**

- A new checkbox added to the Posting Periods window enables to define the default “Due Date To” to be set when creating new posting periods.
- The sorting of columns is now possible within the Posting Periods form.
- Filtering is now possible within the Posting Periods form.
- The *Find* field allows for quick free-text searching.

**Benefit**

- Simplifies and streamlines the creation of new financial periods.
- Enhanced usability of the Posting Periods table, highly significant for businesses with long list of posting periods.
Extend Journal Entry Remarks to 254 Characters and Increase Length of Ref. 3 Fields

**Feature**
- The Remarks field in Journal Entry is extended and may contain up to 254 characters.
- The length of the Ref. 3 fields in the header and rows are increased to 100 characters *(FP2008)*
  See SAP Note 2949589

**Benefit**
- Allows to enter more detailed information related to the journal entry.
- The alignment with Remarks field size in marketing documents fully supports setting it as reference fields, while previously, remarks >50 characters would cut-off when copied to the Remarks in Journal Entry.
Period End Closing - Journal Entry Series

Requirement
- Consistent document numbering in the accounting through the same accounting period,
- French legal requirement for legal audit.

Solution
- Setting for the Journal Entry series for different accounting periods are enabled for Closing and Opening Balances in the Period End Closing Utility,
- Setting for the Journal Entry series in Exchange Rate Differences Report,
- Setting for the Journal Entry series in Conversion Differences,
- Enabled to all localizations.
- SAP Note: 3084579
Fixed Assets Enhancement

Requirements
- Specific G/L account for the Revaluation transactions of Fixed Assets should be used,
- Round fixed assets book value up or down of the whole amount.

Solution
- New Revaluation Account is introduced on Fixed Assets Account Determination,
- Default value: the same as Asset Balance Sheet Account,
- New rounding methods for the Year End Book Value.
- SAP Note: 3083952
# Financial Management

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Warn Message Before Adding Manual Journal Entries</td>
<td>When adding a manual <em>Journal Entry</em> a system message appears to warn that journal entries cannot be changed after adding them. SAP Note <a href="FP2008">2923187</a></td>
<td>All</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Updating Reference Field in Journal Entries with Locked Posting Periods</td>
<td>Update of the Remarks, Ref1, Ref2, Ref3, and User-Defined Fields in journal entries with locked posting periods is enabled. SAP Note <a href="FP2011">2968895</a></td>
<td>All</td>
</tr>
</tbody>
</table>
| Bank Statement Processing (BSP) Enhancements                           | In the **Bank Statement Row – Details: Expanded** window, for bank statement rows whose posting method is **Business Partner from/to Bank Account**:  
  - Distribution rules can be defined  
  - Sales and purchase orders can be added using the **Add Open Documents** window. BSP will create down payment invoices or requests based on the orders  
  In the **Bank Statement Details** window:  
  - For bank statement rows whose posting method is **Business Partner from/to Bank Account**, and for which any document is selected, the control account can be defined  
  - When you have selected the checkbox **No Validation for Starting/Ending Balance** in the **House Bank Accounts - Setup** window, the bank statement can be finalized even if the difference does not equal zero; and the starting balance of your current bank statement can be different to the ending balance of the previous one  
  See more details in SAP Note [2980038](FP2011)                                                                               | All          |
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bank Statement Processing (BSP) Enhancements</td>
<td>In the <em>Bank Statement Row – Details: Expanded</em> window, the values in the <em>Applied Amt - Payment Currency</em> column can be updated. In the Bank Statement Details window, order currency can be different from the local currency. See more details in SAP Note <a href="https://support.sap.com/3031178">3031178</a> (<a href="https://support.sap.com/FP2102">FP2102</a>)</td>
<td>All</td>
</tr>
</tbody>
</table>
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| **Refresh Function in Financial Reports Enabled** | The latest refreshed report will be displayed after clicking the *Refresh* button. The refresh functionality is available for  
- Financials -> Financial Reports -> Accounting -> General Ledger  
- Financials -> Financial Reports -> Accounting -> G/L Accounts and Business Partner  
SAP Note [3047700](FP2105) | All                                                      |
| **Bank Statement Processing (BSP) Enhancements** | When import a bank statement with multiple reference numbers with commas in between in the `<Ustrd>` field of the bank file, those numbers will be separated according to the commas as multiple rows in the *Multiple Payments* window.  
User-Defined Fields (UDFs) can be added as columns in the *Bank Statement Summary* window with the new entry *Bank Statement Processing – Header*  
The *Create Down Payment in Bank Statement Processing* dropdown list for sales and purchase orders on the *Per Document* tab of the *Document Settings* window is now available for the Israel localization.  
See more details in SAP Note [3055456](FP2105) | All                                                      |
Localization
SAP Business One 10.0
New UK (Brexit) Localization

Feature

- New localization introduced for *United Kingdom of Great Britain and Northern Ireland* to support post-Brexit
- In this localization *Make Tax Digital* and *Extended Tax Reporting* are set by default
- See SAP Note [2519116](#)
- *Localization Migration Utility (FP2008)*
  See SAP Note [2912598](#)

Benefit

- Smooth transition from pre-Brexit GB Localization to the new UK Localization
## Localization

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>„Country“ Field Labels Changed to „Country/Region“</td>
<td><em>Country</em> field labels are changed to <em>Country/Region</em>.&lt;br&gt;SAP Note 3021987 (FP2102)</td>
<td>All</td>
</tr>
<tr>
<td>Country/Region Setup Enhancements to Support ISO 3166 Country Codes</td>
<td>The <em>Country/Region</em> fields are populated based on the official ISO 3166 country codes in the <em>Countries/Regions – Setup</em> window.&lt;br&gt;SAP Note 3019691 (FP2102)</td>
<td>All</td>
</tr>
</tbody>
</table>
### Localization

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>GDPR and Classification of Data in Personal Data Management</td>
<td>Multiple data fields are classified as <em>Personal</em> or <em>Sensitive Personal</em> and available for selection in <em>Personal Data Management</em> (Administration → Utilities → Data Protection Tool → Personal Data Management). See details in SAP Note 3031723 (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>
Sales | Purchasing | Service
SAP Business One 10.0
Backorder Report Enhancements

Feature

- **Backorder Report** now displays A/R Reserve Invoices with payment status **Fully Paid**, **Partially Paid** and **Not Paid**
- Reserve Invoice Payment Status is included within the Filter Table

Benefit

- All A/R Reserve Invoices are visible within the Backorder Report
Printing Service Calls and Contracts

Feature
- **Print Preferences** are now available for both Service Calls and Service Contracts
- **Document Printing** includes Service Calls and Service Contract allowing for bulk document distribution

Benefit
- Preference settings on Service Calls and Service Contract printing/emailing
- Bulk processing of service calls and service contracts
**Hide Blank Lines in Addresses**

**Feature**
- A new checkbox within the Address Formats - Setup window allows the hiding of empty address lines
- When selected, ship-to and bill-to addresses in future marketing documents appears without empty lines
- This setting also applies to print layouts for marketing documents defined in Crystal Reports – i.e. empty lines in addresses will also be hidden in the printed documents

**Benefit**
- Enhanced formatting of the printed, previewed, or PDF document
- Easier readability for users within marketing document forms, especially when address format consists of multiple components
Add Button Extended in Marketing Documents
SAP Note 2878515

Feature

- The **Add** button in sales and purchase document creation is enhanced
  - Additionally to the previous common behavior (i.e. after creating and adding a document, the window closes and a new window opens), the following options are now available:
    - **Add & New**: Document is added and a new window opens
    - **Add & View**: Document is added and is displayed
    - **Add & Close**: Document is added and window closes
  - The user’s last choice will be remembered for the given document for the next time

Benefit

- More flexibility in document creation and better handling for users
## Enhanced Open Items List Report

**SAP Note**: 2878483

### Feature

- The *Open Items List* report includes more document information: Owner, Sales Employee/Buyer, Remarks, Approved, Created by, Contact Person, Payment Terms, BP Project, UDFs in document headers.

- The report offers the possibility to close and cancel multiple documents. This feature is supported for these document types: *Sales Quotation, Sales Order, Purchase Request, Purchase Quotation, Purchase Order*.

- In the report multiple *Return Requests* and *Goods Return Request* documents can be closed.

### Benefit

- Easier handling due to more document options and information in one report.
EU PEPPOL E-Invoicing

Feature

- International electronic invoicing platform with a set of rules and specifications that enables electronic communications with any European government institution for procurement processes.
- Electronic documents are sent and received through registered service providers
- See more details and local specifics for PEPPOL protocol in SAP Note 2915144
- General information on PEPPOL integration for the EU in SAP Note 2669994
- Due to own specific electronic invoicing functionality, following localizations don’t support PEPPOL at that time: Argentina, Brazil, Costa Rica, Guatemala, India, and Mexico

Benefit

- Creation and import of documents in electronic format
SAP Business One Sales and Service Mobile Apps
Supported on MS SQL with FP 2105 + App Updates released for iOS + Android updates to come soon

- SAP Business One Sales mobile app for iOS or Android helps manage sales leads, customer accounts, view stock, and place an order.
- With SAP Business One Service mobile app for iOS or Android, maintenance technicians can provide on-site services for their customers easily and efficiently.
- With FP 2105, support for MS SQL databases is enabled. A few HANA-related capabilities are not available with SQL.
- Key updates for both apps on iOS released on August 7th, 2021.
- Key updates for both apps on Android were released on August 23rd, 2021.
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Editing UDFs in Document Rows</strong></td>
<td>A new setting in the Document Settings &quot;Allow Update of User-Defined Fields When Document Rows Are Not Editable&quot; gives the possibility to make UDFs editable independently of the document/row status. New authorization controls user's ability to edit UDFs on marketing document rows. SAP Note <a href="PL01">2872368</a></td>
<td>All</td>
</tr>
</tbody>
</table>
| **Display Business Partner Address UDF with Marketing Document**        | *Business Partners – Addresses UDFs* can be viewed and updated in
  - Address Component window on Logistics tab in marketing documents
  - Address Component window on Business Partner tab of Service Calls
  - Address Formats – Setup window
  See the [Compatibility Issues in SAP Business One 10.0](https://support.sap.com) SAP Note [2872353](PL01) | All          |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create QR Codes</td>
<td>QR (Quick Response) codes can be created on print layouts of marketing documents. New field <em>Create QR Code From</em> is available in <em>Accounting</em> tab of marketing documents. An API service and a free open source library are available for partners to create QR codes. SAP Note <a href="PL02">2889899</a></td>
<td>All</td>
</tr>
<tr>
<td>Adding Multiple Business Partners to One Equipment Card</td>
<td>Multiple business partners can be added to an equipment card. SAP Note <a href="PL02">2906168</a></td>
<td>All</td>
</tr>
<tr>
<td>Updating Group Number</td>
<td>The Group No. on purchase quotations can be changed to the next sequential number in the predefined series. SAP Note <a href="PL02">2896569</a></td>
<td>All</td>
</tr>
</tbody>
</table>
### Feature | Description | Localization
--- | --- | ---
Copying Manual Remarks | Under Administration → System Initialization → Document Settings → General tab → Document Remarks Include section a new option Manual Remarks Only is available. With this option, when using 'Copy To' to copy a base sales, purchasing or inventory document, the 'Remarks' field in the target document will only include the remarks entered by users in the source document, excluding the 'Base Document Number' or the 'Business Partner Reference Number'. SAP Note 2931961 (FP2008) | All
Copy Attachments from Base Document to Target Document | Under Administration → System Initialization → Document Settings → General tab enable checkbox 'Attachments from Base Document to Target Document' to copy documents attachments. SAP Note 2923323 (FP2008) | All
Item Description is Exposed in Alternative Items Window | The column Item Description is exposed in the Alternative Items window. SAP Note 2955529 (FP2008) | All
New Checkbox ‘Duplicate Bar Codes While Duplicating Items’ | A new checkbox Duplicate Bar Codes While Duplicating Items available under Administration → System Initialization → General Settings → Inventory → Item tab. SAP Note 2928480 (FP2008) | All
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Document Status “E-Mailed”</td>
<td>Display status ‘Open; E-Mailed’ and ‘Open; Printed and E-Mailed’ in sales documents, purchase documents, and inventory transfer requests when the document was sent by e-mail. SAP Note <a href="FP2008">2924241</a></td>
<td>All</td>
</tr>
<tr>
<td>Recurring Transaction Templates Selection Criteria Window</td>
<td>When opening the ‘Recurring Transaction Templates’ the ‘Selection Criteria’ window opens to filter the templates. SAP Note <a href="FP2008">2939185</a></td>
<td>All</td>
</tr>
<tr>
<td>Recurring Transaction Templates Recurrence Period Enhancement</td>
<td>‘Recurrence Period’ in ‘Recurring Transaction Templates’ supports the options ‘Every 2 Weeks’ and ‘Every 2 Months’. SAP Note <a href="FP2008">2939183</a></td>
<td>All</td>
</tr>
<tr>
<td>Consider Prices Before Discount Group as Effective Price</td>
<td>Consider prices before discount group as effective price when adding marketing documents. SAP Note <a href="FP2008">2905325</a></td>
<td>All</td>
</tr>
<tr>
<td>Cancelation of Return Request and Goods Return Request</td>
<td>‘Return Request’ and ‘Goods Return Request’ can be canceled. SAP Note <a href="FP2008">2928911</a></td>
<td>All</td>
</tr>
</tbody>
</table>
## Feature: Update Consolidating Business Partner and Consolidation Type on Document Level

View and update the consolidation business partner and consolidation type on the *Accounting* tab is enabled. The default values are taken from the business partner master data and values cannot be changed after the documents are added. This is enabled for the following documents:

- A/R Invoice, A/R Reserve Invoice, A/R Credit Memo, A/R Down Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA), Delivery, Return
- A/P Invoice, A/P Reserve Invoice, A/P Credit Memo, A/P Down Payment Invoice (all localizations except CZ, SK, HU, PL, RU, UA), Goods Receipt PO, Goods Return

The consolidating business partner and consolidation type of the documents generated with the following tools and methods are taken from the base documents and not from the business partner master data:

- Document Generation Wizard
- Payment Wizard
- Billing Wizard
- Copy to
- Copy From

SAP Note [2980002](https://securesitesap.sap.com/ecms2980002?ds=75) (FP2011)
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Items Associated with Canceled Procurement Documents are Displayed in</td>
<td>Items in a sales order / sales quotation / production order associated with canceled procurement documents are displayed in the <em>Procurement Confirmation Wizard</em></td>
<td>All</td>
</tr>
<tr>
<td>the Procurement Confirmation Wizard</td>
<td>SAP Note <a href="FP2102">1804907</a></td>
<td></td>
</tr>
<tr>
<td>Set Default Business Partner Catalog Number</td>
<td>On the <em>BP</em> tab or the <em>Items</em> tab in the <em>Business Partner Catalog Numbers</em> window a user can select a <em>Business Partner Catalog Number</em> as the default for each item from the <em>BP</em> tab, or for each business partner from the <em>Items</em> tab.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="FP2102">3007312</a></td>
<td></td>
</tr>
<tr>
<td>Hide Inactive Contact Person in Business Partner Master Data</td>
<td>A new checkbox <em>Display Inactive Contact Persons in Business Partners Master Data</em> is added to the <em>General Settings → BP</em> tab. This checkbox can be used to determine whether to display inactive contact persons on the <em>Business Partner Master Data → Contact Persons</em> tab.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="FP2102">3009497</a></td>
<td></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
</tbody>
</table>
| Link Between Contact Persons and Business Partner’s Addresses | With the new dropdown list *Connected Address* on the *Contact Persons* tab of the *Business Partner Master Data*, it is possible to link the business partner’s existing  
  - *Bill to*  
  - *Pay to*  
  - *Ship to* address to the selected contact person.  
  SAP Note [2979550](FP2102)                                                                                        | All          |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Referenced Documents Displayed in Document Tree View in Relationship Map</td>
<td>The relationship of referenced documents is displayed in the <em>Marketing Document: Referenced Documents</em> view and in the <em>Marketing Document: Document Tree</em> view. SAP Note 3050215 (FP2105)</td>
<td>All</td>
</tr>
<tr>
<td>Set Default Price List in General Settings instead of in Payment Terms</td>
<td>A new checkbox <em>Set Default Price List in General Settings instead of Payment Terms</em> is available (Administration -&gt; System Initialization -&gt; General Settings -&gt; BP tab) where the default price lists for customers and vendors can be set and in doing so stop using the price list setting in the <em>Payment Terms - Setup</em>. See details in SAP Note 3047725 (FP2105)</td>
<td>All</td>
</tr>
</tbody>
</table>
Project Management
SAP Business One 10.0
Interactive Gantt Chart

**Feature**

- Interactive **Gantt Chart** allows *Project Phases* to be moved or extended/shortened interactively
- New fields added representing *Project Due Date* and *Finish Date*

**Benefit**

- Project updated according to planning changes within interactive Gantt Chart
- Easier and more visual planning of Project Management Tasks
Inventory | Distribution
SAP Business One 10.0
Serial & Batch Numbers Management

**Feature**

- **Serial Number Management** and **Batch Management** now includes the ability to update on **A/R Reserve Invoices** and **Inventory Transfer Requests**
- **Destination Warehouse Code** and **Destination Warehouse Name** now included in the **Serial Number / Batch Management Update** form
- New reports available (PL01):
  - Forward Batches and Serials Trace Report
  - Reverse Batches and Serials Trace Report
  - See SAP Note 2877541

**Benefit**

- More document options when updating Serial Numbers and Batches
- Better reporting on warehouse code on warehouse name on inventory transfer transactions
Support Changing UoM Group in Item Master Data

**Feature**
- **Unit of Measure Groups** may now be changed on an *Item Master Data* record
- To do this, the new UoM Group must have at least the identical set of conversion rules as the original UoM Group
- Only need to “zero down”/close open documents on changed item UoM Groups definitions
- Set UoM in its *UoM Group to Active* (PL01)

See SAP Note 2878890

**Benefit**
- More flexibility in changing UoM group relationships for Item Master data
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Last Prices Report in Item Master Data</td>
<td>Last Prices Report can be opened in the Item Master Data window. SAP Note <a href="https://support.sap.com/2979973">2979973</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Display Preferred Vendor Name in Item Master Data</td>
<td>The Preferred Vendor Name is displayed in the Item Master Data -&gt; Purchasing Data tab. SAP Note <a href="https://support.sap.com/2970897">2970897</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td>Sales/Purchase Item in Item Master Data can be Deselected</td>
<td>When an item that is a component of another item in a bill of material (BOM) the option Sales Item or Purchase Item can be deselected. SAP Note <a href="https://support.sap.com/1329054">1329054</a> (FP2011)</td>
<td>All</td>
</tr>
</tbody>
</table>
### QR Codes for Item Master Data

New field *Create QR Code From* is available in the *Item Master Data*. SAP Note [3060959](https://support.sap.com/3060959) *(FP2105)*

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>QR Codes for Item Master Data</td>
<td>New field <em>Create QR Code From</em> is available in the <em>Item Master Data</em>. SAP Note <a href="https://support.sap.com/3060959">3060959</a> <em>(FP2105)</em></td>
<td>All</td>
</tr>
</tbody>
</table>
Production
SAP Business One 10.0
Bill of Materials (BoM) Description Enhancements

Feature
- Item Description update in the item master data connected to Bill of Materials parent item will be reflected in the Bill of Materials Product Description
- The item and resource descriptions are editable in Bill of Materials and Production Order Components. Additionally, the Item Description can be updated via DI API (PL01)

Benefit
- Item master data record descriptions updated accordingly within the associated Bill of Materials
- Flexible handling of item and resource descriptions in Bill of Materials

See SAP Note 2872529

PL01 Update
Drill Down from BoM to Item Master Data

Feature
- Direct “drill-down” to Item Master Data record now possible from the Parent Item Number

Benefit
- More intuitive and direct navigation between Bill of Materials and Item Master Data
- Flexibility within navigation due to system prompt of navigation choice
## Production

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Production Orders as Base Document in Procurement Confirmation Wizard</td>
<td><em>Production Order</em> can be selected as <em>Base Document</em> in the <em>Procurement Confirmation Wizard.</em> SAP Note <a href="FP2008">2945172</a></td>
<td>All</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| Edit Closed or Canceled Production Orders | When a *Production Order* is closed or canceled, the following fields will be editable:  
- Remarks on the form footer  
- Pick and Pack Remarks on the form footer  
- Reference Document on the Summary tab  
- Attachments on the Attachments tab  
- User-Defined Fields on *Production Order – Title* and on *Production Order – Rows*  | SAP Note [2920833](FP2008) | All |

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete Bill of Materials (BOM) en Masse</td>
<td><em>Bill of Materials</em> (BOM) can be deleted en masse from <em>Bill of Materials Management.</em></td>
<td>SAP Note <a href="FP2008">2926091</a></td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
<td>Localization</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>--------------</td>
</tr>
<tr>
<td>Hidden BOM Components are Not Printed on SAP Crystal Reports</td>
<td>Defined 'Hide BOM Components in Printout' are not printed using SAP Crystal Report layouts. SAP Note <a href="https://notes.sap.com/sap-support/2319313">2319313</a> (FP2102)</td>
<td>All</td>
</tr>
</tbody>
</table>
Platform | Extensibility
SAP Business One 10.0
Service Layer Enabled for Microsoft SQL Server

**Feature**
- Built on core protocols such as HTTP and OData
- Highly scalable (parallel-processing)
- High availability (load balancing)

**Benefit**
- Ready for loosely coupled extensibility running for MSSQL and HANA
Service Layer Configuration UI

Feature

- New **System Landscape Directory URL** for Service Layer configuration
  - `https://<hana-server>:<sld-port>/ServiceLayerController`

Benefits

- No need to edit multiple configuration files
Formatted Search Supports Multiple Triggers

**Feature**
- **User Define Values** support multiple triggers

**Benefit**
- More possibilities and flexibility when implementing formatted searches/user defined values
Extend UDF Support to Additional Objects

Feature

- **User Defined Fields** can be added to more SAP Business One 10.0 objects*
- *Alerts (OALT), Attachment rows (ATC1), Countries (OCRY), Document Numbering Series (NNM1), BP Groups (OCRG), BP Payment Terms (OCTG), BP/Item Properties (OCQG)/(OITG), Item Preferred Vendors (ITM2), Item Prices (ITM1), Manufacturers (OMRC), UoM Master Data (OUOM), Location (OLCT), Package Types (OPKG), Branch Setup (OBPL), and Shipping Types (OSHP)

Benefit

- More possibilities in quick solution customizing
Microsoft Office 365 Integration

Feature

- **Microsoft Office 365** and **OneDrive** integration allows for document layouts, grid results and reports to be exported into Excel and Word accordingly.
- **SAP Business One 10.0 Template Management** allows for more flexibility in reporting and document layouts management.
- **Microsoft Office 365** integration starting with **SAP Business One Cloud 1.1 PL17 (FP2102)**
  See SAP Note [3018885](#).

Benefit

- Automatic upload of exports into OneDrive
- Easier report and document layouts management
- Access from everywhere
Document Information Extraction

Feature

- Scanning PDF documents and extract invoice header and item information
- Create A/P invoice in SAP Business One
- See SAP Note 3021904

Benefit

- Automatic generation of A/P invoice drafts out of PDFs
- Let employees save work time and focus on new activities
64-bit Only Support

Feature

▪ SAP Business One will support only 64bit Windows operating system
▪ Only 64-bit add-ons will be supported with SAP Business One 10.0

Benefit

▪ Smaller software package downloads (due to removal of redundant 32-bit executables)
Gatekeeper (Browser Access) Service

**Feature**
- SAP Business One Client UI is rendered and published via gatekeeper service over the HTTPS protocol

**Benefit**
- Easy access
- No local client is needed
Web Client - Extensibility Support

- Ability to package web applications with VSCode (URL mashups, Apps), Based on Fiori/Angular/React/Vue frameworks
- Support Tiles Image
- UI-API Framework - Internal prep
## Platform & Extensibility

See also the SAP Business One Platform Support Matrix ([MS SQL / SAP HANA](https://example.com/support_matrix))

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>SAP HANA 2.0 Platform Adaption</strong></td>
<td>SAP HANA 2.0 supported only</td>
<td>All</td>
</tr>
<tr>
<td><strong>Support SLES 15</strong></td>
<td>Suse Linux Enterprise Server SLES 15 only</td>
<td>All</td>
</tr>
<tr>
<td><strong>SAP HANA 2.0 Platform Adaption for Remote Support Platform 3.2</strong></td>
<td>RSP 3.2 supports SAP HANA 2.0</td>
<td>All</td>
</tr>
</tbody>
</table>
| **Integration Framework for SAP Business One**                          | Additional System Types in System Landscape Directory available: SAP Business One 10.0  
SAP Business One Generic  
S/4 HANA on Premise  
SAP Note [2857220](https://example.com/2857220) | All          |
| **SAP Business One integration for SAP NetWeaver**                      |                                                                            |              |
| **DI API: Blocking Updating Address ID in Business Partner Master Data through DI API** | New checkbox *Allow to Update Address ID* added to the *Administration* -> *System Initialization* -> *General Settings* -> *BP* tab.  
This checkbox is selected by default.  
When deselecting the checkbox the *Address ID* field cannot be edited and updated through DI API; an error message appears. | All          |

© 2021 SAP SE or an SAP affiliate company. All rights reserved. | PUBLIC
## Feature

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| **DI API and Service Layer:**  
Recurring Postings | Recurring Postings exposed to DI API and Service Layer  
SAP Note [2878517 (PL01)](https://support.sap.com) | All |
| **DI API and Service Layer:**  
Posting Template | Posting Templates exposed to DI API and Service Layer  
SAP Note [2878484 (PL01)](https://support.sap.com) | All |
| **DI API and Service Layer:**  
Cancel and Restore Approval Requests | New methods added to cancel and restore Approval Requests in DI API and Service Layer  
SAP Note [2859177 (PL01)](https://support.sap.com) | All |
| **DI API:**  
Additional Reference Documents | Additional document referencing for  
Goods Receipt, Goods Issue, Purchase Request, Inventory Transfer, Inventory Transfer Request, Checks for Payment  
SAP Note [2866114 (PL01)](https://support.sap.com) | All |
## Platform & Extensibility

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>MS SQL Server 2019</strong></td>
<td>SAP Business One supports Microsoft SQL Server 2019</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="PL02">2877473</a></td>
<td></td>
</tr>
<tr>
<td><strong>Service Layer: Supports SQL View Exposure</strong></td>
<td>Service Layer on Microsoft SQL can discover and expose regular customized SQL views in OData V3/V4 protocol</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="PL02">2912563</a></td>
<td></td>
</tr>
<tr>
<td><strong>Service Layer: Configuration Controller</strong></td>
<td>Configuration Controller for Service Layer is available, providing a user-friendly interface to update configuration parameters.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="PL02">2912506</a></td>
<td></td>
</tr>
<tr>
<td><strong>API Gateway</strong></td>
<td>API Gateway is available to access business data with a unified service endpoint, providing a one-time authentication to access Crystal Reports.</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="PL02">2890290</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td>See <a href="https://help.sap.com">What's New</a> in SAP Business One 10.0</td>
<td></td>
</tr>
<tr>
<td><strong>SAP Crystal Reports 2016 SP7</strong></td>
<td>SAP Crystal Reports 2016 SP7, version for the SAP Business One application is available</td>
<td>All</td>
</tr>
<tr>
<td></td>
<td>SAP Note <a href="PL02">2584094</a></td>
<td></td>
</tr>
</tbody>
</table>
## Platform & Extensibility

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Linking UDF on UDT to System Objects and UDO</td>
<td>An UDF on a system form can be linked to a system form, user-defined table (UDT), or a user-defined object (UDO). SAP Note <a href="https://support.sap.com/2949633">2949633</a> (FP2008)</td>
<td>All</td>
</tr>
</tbody>
</table>
| Service Layer and DI API: More Properties in SalesPersons Object for Sales Employee Exposed | The following properties of the SalesPersons object (database table OSLP) are available in the DI API and Service Layer:  
- Telephone  
- Mobil  
- Fax  
- Email  
SAP Note [2932743](https://support.sap.com/2932743) (FP2008) | All |
SAP Note [2936980](https://support.sap.com/2936980) (FP2008) | All |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Certificates Enhancements for Lightweight Extensions</td>
<td>Trusted certificate for add-ons running in the landscape is needed. The add-on security mechanism will verify registered add-ons. SAP Note <a href="FP2011">2979022</a></td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: GetAddressFormat and GetFullAddress Exposed</td>
<td>In the Service Layer <code>GetAddressFormat</code> and <code>GetFullAddress</code> exposed as new <code>AddressService</code>. SAP Note <a href="FP2011">2990130</a></td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: Supports SQL Query</td>
<td>The Service Layer on Microsoft SQL Server and SAP HANA supports SQL Query to enhance the query capability of the Service Layer and to reduce manual effort to deploy views. SAP Note <a href="FP2011">2970896</a></td>
<td>All</td>
</tr>
<tr>
<td>Service Layer: JavaScript Extension Works with oData Version 4.0</td>
<td><code>JavaScript Extension</code> works with oData Version 4.0 in Service Layer. SAP Note <a href="FP2011">2959007</a></td>
<td>All</td>
</tr>
<tr>
<td>Service Layer and DI API: Holiday Dates Exposed</td>
<td>Holiday date objects are exposed through Service Layer and DI API. SAP Note <a href="FP2011">2970998</a></td>
<td>All</td>
</tr>
</tbody>
</table>
## Platform & Extensibility

### Feature Description

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DI API: Insert Rows at any Place in Production Order</strong></td>
<td>Insert rows at any place within the Production Order grid via the DI API. SAP Note <a href="https://support.sap.com/notes/2985713">2985713</a> (FP2011)</td>
<td>All</td>
</tr>
<tr>
<td><strong>DI API: License Check Function Exposed</strong></td>
<td><code>SBObob.GetLicenseStatus</code> is exposed on the DI API to be able to find out whether a user has a license to access a form. SAP Note <a href="https://support.sap.com/notes/2970960">2970960</a> (FP2011)</td>
<td>All</td>
</tr>
</tbody>
</table>
## Platform & Extensibility

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
</table>
| Set Default Layouts for Documents/Reports and Printing Sequences in Report and Layout Manager | The report and layout manager has been enhanced to set the following defaults directly in the report and layout manager:  
- Set default layouts for each type of document/report  
- Set default layouts for printing sequences  
- Set a system layout as inactive  
SAP Note 3024856 (FP2102) | All |
| Document Information Extraction Service | Document Information Extraction is a service (API) from SAP that automatically reads and extracts information from digital document files and scanned documents.  
SAP Note 3021904 (FP2102) | All |
| Service Layer and DI API: Support UserSign of Documents | The UserSign property is available to identify documents based on the user who created them. This allows to filter and search for documents based on the creator.  
SAP Note 3003222 (FP2102) | All |
| Service Layer: Query Supports User-Defined Tables (UDTs) | The Service Layer SQL Queries supports User-Defined Tables (UDTs).  
SAP Note 3009505 (FP2102) | All |
## Platform & Extensibility

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
<th>Localization</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-Defined Fields Link to Sales Persons (OSLP)</td>
<td>When creating User-Defined Fields (UDFs), the <em>Linked to Entities</em> function can be used to link the UDF to Sales Persons (DB table: OSLP). SAP Note 3003178 (FP2102)</td>
<td>All</td>
</tr>
<tr>
<td>Retrieve Current Logged User in User Query</td>
<td>In the SQL statement of an SAP Business One user query a new parameter $[USER]$ is available which reads out the ID of the current logged user. This parameter can be used to track the current user. SAP Note 3009652 (FP2102)</td>
<td>All</td>
</tr>
</tbody>
</table>
Thank you.